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Object Selection Tool

In this lesson, we’re going to learn about the Ob-
ject Selection Tool, which was added to Photo-
shop in November of 2019. The Object Selection 
Tool can be found in the Toolbar on the left side 
of Photoshop’s interface. It is grouped with the 
Quick Selection Tool and the Magic Wand Tool. 
This tool works in the way that the Lasso Tool 
SHOULD work (in my opinion.) You’ll use it to drag out a shape around the object 
you want selected and when you release the mouse button, Photoshop will con-
tract the shape in an attempt to accurately select the object. It’s kind of like throw-
ing a lasso rope around something and then pulling it taut. 

If the subject is really prominent and stands off of the background nicely, you don’t 
even need to draw out a selection. You can simply click the “Select Subject” button, 
which can be found in the Options Bar when the Object Selection Tool is active. 
This will cause Photoshop to make a selection around what it thinks the subject is. 
This does a better job on simpler images where the subject stands out really well. 

How to Use the Object Selection Tool (Timestamp 4:00)

To use the Object Selection Tool, drag 
out a rough shape that surrounds the 
subject you’re trying to select. When 
you release the mouse button, Pho-
toshop will contract the selection to 
select only the subject. The accuracy 
of the selection will depend on how 
different the subject is from the sur-
roundings. It’s common to need to 
tweak the resulting selection and we 
have some tools for doing this. 

The Object Selection Tool is grouped 
with the Quick Selection and Magic 
Wand Tools in the Toolbar. 

Use the Object Selection Tool to draw a shape 
around the subject. When you release the mouse 
button, the selection will contract to fit the  
subject.
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Options Bar icons  When the Object Selection 
Tool is active, some icons appear on the left side 
of the Options Bar, which is located above the 
image window. When the left-most icon is ac-
tive, the tool will create a brand new selection 
the next time you click in the image. This is the 
icon that is active by default. When the second 
icon is active, the tool will add to the selection 
that is currently active. When the third icon is 
active, the tool will subtract from the selection. 
This is useful when the initial selection includes 
more than just the subject. 

The Object Selection Tool does a better job when the subject stands out from the back-
ground, as you can see in the image on the left. In the image on the right, the subject is very 
similar to its background and you can see that the resulting selection was not at all accurate.

The icons in the Options Bar control 
how the Object Selection Tool  
behaves.
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When using the subtract 
mode, you need to pay atten-
tion to the “Object Subtract” 
check box that is also found in 
the Options Bar. If this setting 
is turned off, the tool is going 
to blatantly subtract the exact 
shape that you drew out with 
your cursor. It will not try to 
contract the shape to fit the 
subject. When the “Object 
Subtract” check box is turned 
on, it will detect the edges of 
objects and attempt to smart-
ly remove part of the selec-
tion. When the fourth icon is 
active, it will create an inter-
section between two selections. With this, you would draw out a new selection 
around part of a current selection and the result will be a selection that contains 
only the areas that both selections isolated. 

There are some keyboard shortcuts that more easily allow you to access the func-
tionality of these icons. You can keep the first icon active, which is the setting that 
creates a new selection. After making a selection, you can hold down the Shift key 
to add to the selection or you can hold down the Option key (Alt on Win) to take 
away from the selection.

Additional Options (7:45)

The Mode menu The Mode menu in the Options bar 
allows you to switch between using the tool to draw 
out a simple rectangle around the subject or using the 
tool to manually draw out a shape using the Lasso.  

I’m holding down the 
Option key (Alt on 
Win) while dragging a 
shape around an area 
that was accidental-
ly selected. This tells 
the tool to subtract 
from the selection. 
The “Object Subtract” 
check box is turned 
on, which means the 
shape I’m drawing out 
does not need to be 
exact. 

The Mode menu can be found 
in the Options Bar.
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Sample All Layers This setting is also found in the Options bar. You’ll want this 
turned on if you are working with a multi-layered document so that the tool can 
see and select from the contents of more than one layer. 

Auto-Enhance Turning this check box on will give you a smoother edge when you 
use the Object Selection Tool. It may cause the tool to work a little slower but I 
usually keep it on because the results are better. 

Touch-up Techniques (9:27) 

After using an automated selection tool like this, it is not at all uncommon that 
you’ll need to touch up the selection. Let’s look at some methods for doing that. 
The first thing I usually do is type the Q key to enter Quick Mask Mode. In this 
mode, anything that is not selected will be covered in red. If you see the red overlay 
in an area that should be included in the selection, you can use the Brush Tool to 
paint with white over that area. Painting with white will remove the red overlay and 
therefore add to the selection. 

When the Mode 
menu is set to  
Rectangle, you can 
use the Object  
Selection Tool to 
draw out a rectangle 
around the subject. 
When you release  
the mouse button, 
the rectangle will 
contract to the shape 
of the subject.
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It can sometimes be useful to swap the 
area where the red appears and you can 
do that by using the keyboard shortcut 
Command+I (Ctrl+I on Win). This will in-
vert the mask and allow you to better 
see if you’re missing some areas that 
should be selected. If so, you can paint 
with black to add the red overlay to the 
area that should be fully selected. Just 
remember to invert the mask again when 
you’re finished so that the appropriate 
area is selected. 

When painting on a mask like this, you can hold down the ~/` key (directly above 
Tab) to temporarily switch the tool to add or subtract from the selection, or mask. 
For example, if you are painting with white to add to a mask, you can hold down 
the ~/` key to temporarily paint with black to remove from the mask. This is a new 
feature that was added in November of 2019. 

You can inspect and refine a selection by viewing it in Quick Mask Mode, which places a red 
overlay over all areas that are not selected. At right, I am refining the mask by painting with 
white over an area that should be selected. 

The layer mask was inverted and I am  
painting with black to refine the selection.
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Select & Mask This is another feature that is designed to refine selections. If a se-
lection tool is currently active, then you can access this tool by clicking on the Se-
lect & Mask button in the Options Bar. If you’re not currently using a selection tool, 
you can click on the Select menu and choose Select & Mask. The Select & Mask 
window will appear and it will take up the entire Photoshop interface. At the top of 
the settings panel on the left is the View menu. This gives you several options for 
ways of viewing the mask. I often times like to choose the Overlay option, which 
gives a similar view to Quick Mask Mode. 

The image is being viewed in the Select & Mask window. Here, the view menu (circled) was 
set to Overlay so that we’re viewing the image with a similar red overlay to that of Quick Mask 
Mode. 
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With this view, it can be easier to see if the edge of the selection is not precise. In 
the example image, we can see that there is a little bit of halo around the subject, 
where the selection needs to contract a bit. When this happens, I’ll first turn to the 
Radius slider. This slider will give Photoshop control over the edge of the selection, 
based on how high of a pixel radius you set. If you set this slider to one pixel, then 
you’re giving Photoshop control of one pixel’s radius all the way around the selec-
tion edge in an attempt to enhance it. In the video example, this helped to eliminate 
the halo around the subject. 

If part of the subject is furry, 
fuzzy or hairy, then the sec-
ond tool in the left-side tool-
bar can be useful. Activate 
this tool and then paint over 
the selection edge where the 
hairy part is located. This will 
give Photoshop control over 
the area where you paint so 
that it can refine the edge 
automatically. 

The third tool in the toolbar is the Brush Tool and you can use this to manually add 
or take away from the selection. Photoshop will not have any control when you use 
the Brush Tool. With this tool active, the brush will add to the selection by default. 
You can use the plus (+) and minus ( - ) icons above the image window to specify 
whether the tool should add to or take away from the selection. 

The second tool can be used to paint over areas that are 
fuzzy or hairy. This will give Photoshop control over the 
selection edges in the areas where you paint. 
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Isolating a Hairy Subject (14:26)

The Select Subject button will not do a very good 
job when the subject has parts that are hairy or fur-
ry because it’s trying to make a solid, clean-edged 
selection. In a case like this, I might use the Select 
Subject setting as a starting point and then I’ll enter 
the Select & Mask tool. In the Select & Mask window, 
I’d choose the second tool in the left-hand toolbar 
and I’d use this brush to paint over the areas where 
the hair meets the red overlay. (The red overlay ap-
pears because I have the View menu set to Overlay.) 
This tool gives Photoshop control over the selection 
in all the areas where you paint. Then, I’ll look for 
any crevices where the background is not covered 
with red and I will use a small brush to paint over 
those areas too. Once I’m satisfied with the selec-
tion, I’ll click OK to exit the Select & Mask window. 

The Object Selection Tool did 
not do a very good job where 
the hair meets the background.

The second tool in the Select & Mask window is being used to paint over the hair area. This is 
giving Photoshop control over the selection edge in this area.
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There will be a “marching 
ants” selection around the 
subject in Photoshop. I can 
use this selection to cre-
ate a layer mask simply by 
clicking the Layer Mask icon 
at the bottom of the Layers 
panel. Whenever you cre-
ate a layer mask while there 
is an active selection, that 
selection will be applied 
to the mask. The selected 
area will be the white part 
of the mask, which is the 
area that’s visible. This will 
isolate the subject against 
a transparent background 
(providing I was working on 
a single-layer document). 

I could place the subject 
on a new background by 
creating a solid color layer 
and placing it beneath the 
subject layer. In the video 
example, I’ll place a red sol-
id color layer beneath the 
subject. When I do this, the 
results don’t look that great and that’s because it’s very difficult to extract a hairy 
subject from a black background without getting a dark halo effect. 

The selection was converted into a layer mask, therefore 
hiding the background. 

A Solid Color layer was placed beneath the image layer and 
we can see that there is still a dark halo around the hair 
from the original background.
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If you ever have this problem there’s one more setting you can try. I’ll make sure the 
layer mask is active and I’ll enter the Select & Mask tool again (Select menu > Select 
& Mask). Here, I’ll scroll down the settings panel to the Output Settings category 
and I’ll turn on the “Decontaminate Colors” check box. This will try to find and elim-
inate the old background color in the areas that are partially transparent. There is 
a slider beneath this check box that allows you to control the amount of the effect. 

Isolating a Hairy Subject: Part 2 (42:09)

In the lesson video, I return to this image at the end of the lesson so that we can 
further refine the results. That’s why the timestamp doesn’t fall in order with the 
rest of the techniques.

In the Select & Mask window, the “Decontaminate Colors” check box is turned on. This will  
attempt to remove any residual color from the original background.
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After using the Select & Mask tools, we 
can still see parts of the background 
showing through in the area where the 
subject’s hair is. To correct for this, I’ll 
start by creating a Curves Adjustment 
Layer at the top of the Layers panel. 
I’ll make sure the Targeted Adjustment 
Tool is active. It looks like the little hand 
icon on the left side of the Curves Prop-
erties panel. I’ll use this tool to click 
within the part of the hair area that looks 
dark from the old background showing 
through. This will target that area by placing a point on the curve. Then, I’ll move 
that dot up in the curve chart. This will brighten the targeted area. 

We can still see the residual dark background 
around the hair area.

A Curves Adjustment Layer was created and the Targeted Adjustment Tool is being used to 
click within the part of the hair that looks dark from the original background.
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The problem is that it acts as if it’s 
adding white light, and because the 
subject has blonde hair, it looks too 
bright. To improve this, I’ll set the color 
menu above the Curves chart to Blue. 
I’m doing this because I want to af-
fect the yellow tones (because of the 
blonde hair) and yellow is the oppo-
site of blue. As I reduce blue, the yel-
low will become increased, so I’ll click 
on the upper right corner of the blue 
curve line and I’ll drag it down a bit. As 
I do this, you can see the image be-
coming a little more yellow. 

The entire image becomes more yellow, and that’s not what I want. I don’t want 
the adjustment to affect the background. To prevent this, I’ll click the left-most 
icon at the bottom of the Curves Properties panel. This will clip the layer to the one 
beneath it, which means the Curves adjustment will only be visible in areas where 
the underlying layer is visible. Then, I’ll further limit the area where the adjustment 
is visible by painting on the layer mask that is attached to the Curves Adjustment 
Layer. 

With the mask active, I’ll click on the Image menu and choose Adjustments > Invert. 
This will cause the entire mask to be black, which means the adjustment will be vis-
ible in no parts of the image. Then, I’ll activate the Brush Tool and use a soft-edged 
brush to paint with white over the areas where I want the effect to be visible. This 
is the area where you could see the original dark background through the hair. 

Finally, I’m going to further refine the mask that is attached to the main image layer. 
The edges of the mask look too crispy in this area. To fix this, I’ll make sure the layer 
mask is active and then I’ll activate the Blur Tool. This tool looks like a water drop 
icon in the Toolbar on the left side of the interface. I’ll use this tool to paint over the 
hair in that area, adding a little softness to the layer mask. 

The color menu 
above the Curves 
chart is being set 
to blue. The  
opposite of blue is 
yellow, so this will 
give us control 
over the yellows in 
the image. 
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Selecting an Object in a Complex Image (18:48)

If there is a lot going on in an image, it will be difficult for the Select Subject but-
ton to figure out where the subject is. That’s the case in the image of the old sign 
made up of light bulbs. I’ll undo the selection made with that button and I’ll use the 
Object Selection Tool (set to the Lasso Mode) and carefully draw out a selection 
around the big number five that I want to select. As I’m doing this, I’ll be careful to 
not include areas that Photoshop might confuse with the subject. 

The result is ok, but not amazing, so let’s look at how we can refine it. I’ll start by 
trying to add to the selection in order to include the side part of the number five. I’ll 
hold down the Shift key (which tells the Object Selection Tool to add to a selection) 
and I’ll draw out another shape around the area I want to add, overlapping the area 
that is already selected.  When I release the mouse button, it does a good job of 
adding to the selection to include the side part of the sign. I’ll repeat this process 
for the other parts of the number five sign that I want to be selection. 

LEFT: The Select Subject button did not do a good job of selecting the number five.  
CENTER: The Object Selection Tool is being used to carefully draw a shape around the five. 
RIGHT: The result is a much better selection.
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Now there are areas that I’d like to remove from the selection. For example, there 
is a hole in the sign where you can see through to the background. I don’t want 
this little piece of background to be included in the selection. I’ll first make sure 

that the “Object Subtract” check box is 
turned on, I’ll hold down the Option key 
(Alt on Win) to make the Object Selec-
tion Tool subtract from a selection and 
I’ll draw out a little shape around that 
little piece of background. When I re-
lease the mouse button, it will remove 
that area from the active selection. I’ll 
repeat this process for any other areas 
that should not be selected.

The Shift key is being held down so that the Object Selection Tool adds to the selection as I 
drag out shapes around parts of the five that should be selected.

LEFT: The Option key (Alt on Win) is being 
held in order to subtract from the selection. 
RIGHT: The yellow background was removed 
from the selection.
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I’ll enter Quick Mask Mode (by tapping the Q key) to better inspect the selection. 
With this red overlay, I can see one or two areas that need to be touched up so I’ll 
exit Quick Mask Mode, make the touch-ups using the Object Selection Tool and 
enter Quick Mask Mode again to see if my work was sufficient. I’ll continue this 
process, looking at the image in Quick Mask Mode and making any necessary mod-
ifications. 

When I’m happy with the results, I’ll add a layer mask. The selection will be applied 
to the mask so that the only visible part of the layer will be that number five that I 
had selected. 

Selecting a Complex Subject: Fireworks (23:20)

The Object Selection Tool is going to have some trouble with the next video exam-
ple image as well. Here, we have an image of a firework exploding. When I use the 
Select Subject button, it creates a selection around the perimeter of the firework, 
as if it were a flower. It can’t tell the difference between sky and firework toward the 
center. I’ll use a different technique to try and select this firework. 

After the selection 
was refined, a layer 
mask was added, 
which isolated the 
subject from the 
background.
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I’ll start by creating a simple rectangular selection of part of the dark sky in the 
background. Then, I’ll click on the Select menu and choose “Similar.” This will cause 
Photoshop to scan the entire image and select everything that is similar to what’s 
contained in the selection. This does a pretty good job of selecting the entire dark 
sky. 

The Object  
Selection Tool did 
not do a good job 
of selecting this 
firework. You can 
get a better view 
of the selection 
with the red  
overlay of Quick 
Mask Mode.

FAR LEFT: The 
Rectangular Mar-
quee Tool is being 
used to make a 
simple selection of 
the background. 

DIRECTLY LEFT: 
The “Select Simi-
lar” command was 
used and you can 
see it selected the 
entire sky.
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Now it’s the firework that I want selected so I’ll click on the Select menu and choose 
Inverse. This selects the firework and some of the lights from the town at the bot-
tom of the image. I only want the firework selected, so with the Rectangular Mar-
quee Tool still active, I’ll hold down the Option key (Alt on Win) and drag out a 
rectangle over the lights at the bottom of the image. Holding down the Option key 
will cause the tool to subtract from the selection so this leaves me with only the 
firework selected. 

I’ll tap the Q key to enter Quick Mask Mode so that I can inspect the selection. I 
see that the edges are a little rough so that means it requires further refinement. I’ll 
click the Select menu and choose Select & Mask. When the Select & Mask window 
appears, I’ll make sure that I’m using the Overlay view mode, which looks similar to 
Quick Mask Mode. Then, I’ll drag the Radius slider up, giving Photoshop more and 
more control over the edges of the selection. I’ll move the slider up until all of the 
black patches of sky are covered with the red overlay. Then I’ll click OK to exit the 
Select & Mask window. 

In the Select & Mask window, the Radius slider is being dragged up in order to remove any  
extra dark sky from the selection.
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Subject Similar to Background (27:37)

In this next example, I first used the Select Subject button and it did not do a good 
job of finding the subject. I’ll undo this selection and instead use the Object Selec-
tion Tool, set to the Lasso Mode. I’ll draw out a shape that runs close to Karen (the 
subject) so that the tool is not likely to get confused by some of the surrounding 
background elements. When I release the mouse button, I see that it still did a bad 
job of finding the subject. It selected part of the background (that shouldn’t be se-
lected) and failed to select part of Karen (who should have been selected). 

With the Object Selection Tool still active, I’ll 
hold down the Option key (Alt on Win) and 
then draw out selections over the part of the 
background that should not have been select-
ed. Holding down the Option key will tell the 
tool to subtract from the selection. I’ll then 
hold the Shift key while dragging out selec-
tions around parts of the subject that should 
be selected. Holding the Shift key will cause 
the tool to add to a selection. I’ll continue to 
use this method to subtract from and add to 
the selection where appropriate. 

ABOVE: The Object Selection Tool is 
being used to draw a shape around 

the subject. RIGHT: The results were 
nowhere near accurate.

The Object Selection Tool is being used 
in an attempt to remove unwanted back-
ground from the selection.
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After I’ve done as much as I can with the Object Selection Tool, I’ll tap the Q key 
to enter Quick Mask Mode so I can view the selection with the red overlay. In this 
mode, I can use the Brush Tool to refine the selection. I’ll use a small brush and paint 
with black in any areas that should NOT be selected (but currently are). This will 
add the red overlay to those areas, indicating that they are not selected. I’ll paint 
with white over all the areas that SHOULD be selected, removing the red overlay 
from all parts of the subject. 

Now that the selection is looking a little better, I’ll refine it further with the Select 
& Mask tool. In the Select & Mask window, I’ll use the second tool to paint over the 
areas where her hair meets the background. This will give Photoshop control over 
the selection edges in those areas. When I’m satisfied, I’ll click OK to exit the Select 
& Mask window. 

The second tool in the Select & Mask window is being used to refine the selection.
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Object Selection Tool and Select & Mask 

You can also use the Object Selection Tool right within the Select & Mask window. 
It’s the fourth tool down in the toolbar on the left side of the screen. When it’s ac-
tive, all of the related settings will appear above the image window. So if you know 
that you’re going to end up in the Select & Mask window, you could start there, 
using the Object Selection Tool right within the window, and then continue to use 
the other tools associated with the Select & Mask feature. 

Looking at these examples, you can see that I use ALL of the selection tools. I try to 
use automated tools as much as I can because they save time. When they mess up, 
I need to fall back on more manual tools so it’s good practice to stay familiarized 
with all of them. 

The Object Selection Tool is being used, right within the Select & Mask window, to make an 
initial selection of the subject.


